Quick Start Guide

For today’s financial professional.
Your new desktop has arrived.

CONTENTS:
Install and Sign In ................................................................. 2
Basic Navigation ..................................................................... 4
Use your Floating Workspace ................................................ 7
Monitor your Portfolios ......................................................... 12
Charting and Technical Analysis ........................................... 14
Financial Communities ......................................................... 16
Thomson Reuters Eikon – Microsoft Office ......................... 18
Install and Sign In

I. INSTALL THE APPLICATION

Does my computer meet the requirements for Thomson Reuters Eikon?
2. Click Check My Computer.
3. Follow the on-screen instructions to run System Test.

How do I get my Thomson Reuters Eikon account?
1. Your company’s Market Data team or Thomson Reuters Account Manager requests a Thomson Reuters Eikon ID on your behalf.
2. You receive a Welcome email from Thomson Reuters Eikon.
3. Click the link in the Welcome email to activate your account.

How do I install Thomson Reuters Eikon?
After checking that your computer meets the requirements and activating your account, you are ready to install Thomson Reuters Eikon:
2. Click Sign in & Download.
3. Follow the on-screen instructions to install Thomson Reuters Eikon.

II. SIGN IN

On your desktop
1. Point to Start > Programs > Thomson Reuters and choose Thomson Reuters Eikon.
2. Type your user ID and password.
3. Select Sign me in automatically to avoid signing in the next time you start the application.
4. Click Sign In.

On your mobile device
The single sign-on (SSO) feature with single exchange fees lets you access Thomson Reuters Eikon on iOS, Android, and BlackBerry devices.

On the web
You can now access key Thomson Reuters Eikon news and data on the web, without having to download an application. Just go to http://eikon.thomsonreuters.com/login and use your user ID and password.

III. CONTACT SUPPORT

If you cannot sign in
Unable to sign in? The most likely cause is an incorrect password or no Internet connection.

Thomson Reuters Eikon online help provides a number of troubleshooting solutions: http://bit.ly/14ItX8u (sign-in not required)

After logging in, you can always access help by pressing F1 or using the right-click menu.

Should none of these solutions work, contact Thomson Reuters:
1. Click the Contact Us link in the Sign In dialog box.
2. Fill in the Contact Us page that appears, and click Submit.

For eLearning, go to http://training.thomsonreuters.com/eikon/mobile-solutions
Get support after signing in
If you encounter problems when working with Thomson Reuters Eikon or receive error messages and would like more information, you can contact Support.
Go to 📩 > Help > Contact Us.

Get more help
- Click 🤝 in the top right of your toolbar to find out what’s new in Thomson Reuters Eikon.
- Go to 📩 > Help for all help-related options.
- For more detailed information on installation, configuration, or migration, see online help for Thomson Reuters Eikon Installation & Configuration: http://bit.ly/19OyDnz.
- My Account (http://financial.thomsonreuters.com/myaccount) is the single online entry point to Thomson Reuters service and support. You can find numerous documents, including the latest version of this guide.

Get training
Type TRAINING into the Search box to open the Training App:
- View on-demand video tutorials to help you get the most out of Thomson Reuters Eikon.
- Learn the basics so you can get up and running quickly.
- Explore learning by segment to ensure you are making the most of the tools available for your market.
- Bookmark training so you can complete it at a time convenient to you.

IV. CUSTOMIZE YOUR PROFILE
Create your profile
When you sign in for the first time, Thomson Reuters Eikon prompts you to customize your profile. Be sure to fill in Job Functions and Asset Classes: this information is used to suggest the features and apps most appropriate for your role.
You can:
- import your LinkedIn™ profile
- add a photo
- fill in your work history and education
- give details about your job role in General Info
- enter contact details
This information appears in the Thomson Reuters financial directory and improves the results of people-related searches.

Update your profile
You can edit your profile information at any time.
Go to 📩 > Preferences > My Profile to reopen your profile page and make your changes.
Basic Navigation

I. GET TO KNOW THE TOOLBAR

Immediately after logging in, the toolbar appears at the top of your screen.

**Tip:** To move the toolbar, just right-click it and choose *Undock*, then drag it to a new position.

II. FIND APPS AND DEFINE SETTINGS

III. SEARCH FOR CONTENT AND GET ANSWERS

IV. BOOKMARK YOUR FAVORITE CONTENT FOR EASY ACCESS

---

**Thomson Reuters Eikon button.** Click here to access the app menu, App Library, saved workspaces, settings, and Help.

**The Search box is powered by** *Autosuggest* and *Answers*. Use it to find apps, data, or answers to your questions. For more information, see page 5.

---

For more help, see Welcome to the Desktop: [http://bit.ly/1bIXT7S](http://bit.ly/1bIXT7S)

For eLearning, choose *Getting Started with Eikon: New User* from the Learn the Basics category in the Training App.
II. FIND APPS AND DEFINE SETTINGS

- Click to open the app menu.
- My Apps features apps for your specific asset class. You can add, remove, or rearrange apps in this menu.
- Other apps are displayed by category.
- Click any app to open it.
- My Workspaces holds all your saved workspaces and layouts.
- The App Library is a searchable database of all apps.
- Click Preferences to define global options, trading settings, and more.
- Click Help to access online help, to contact us, to find out what’s new, and other support options.

III. SEARCH FOR CONTENT AND GET ANSWERS

Search box: a starting point for your workflow

The Search box is your starting point to navigate anywhere. Just start typing and Autosuggest will propose results.

1. Start typing Vodafone in the Search box.
2. Autosuggest displays results.
3. Click a result to load content. For example, you can open the Chart App with data for Vodafone already loaded.
4. If you don’t find what you are looking for, press Shift+Enter or click here to run an advanced search.

Sample searches

<table>
<thead>
<tr>
<th>Company names or common abbreviations</th>
<th>Microsoft, Vodafone, ibm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Descriptive terms</td>
<td>Comex copper, vodafone common stock</td>
</tr>
<tr>
<td>Standard industry codes</td>
<td>Ticker, ISIN, Cusip, Sedol, WERT</td>
</tr>
<tr>
<td>Specific and partial codes</td>
<td>US4592200HJ3, MSFT, USTB</td>
</tr>
<tr>
<td>Ticker, coupon, and maturity</td>
<td>VOD &gt;7.5%, Vodafone 2015</td>
</tr>
<tr>
<td>Country names for country guides</td>
<td>France, UK, Japan</td>
</tr>
<tr>
<td>News searches on specific instruments or topics</td>
<td>IBM news, China news, UST news</td>
</tr>
</tbody>
</table>
Answers: ask your questions in natural language
Type a query using natural language. Thomson Reuters Eikon Answers will appear at the top of the results.

1. For example, you want to compare recent top-line trends for Ford and GM. Type Ford vs GM sales.

2. Autosuggest interprets your query. ANS prefixes results from Answers. Click the result that matches your question to view a detailed revenue chart comparing Ford and GM.

Tip: You can find answers to frequently-asked questions. Start typing How do I... and you will see FAQs in the Search results.

Sample Answers queries
Ford vs GM sales
Google EBITDA estimate
French tech companies

For more help and to see examples, type ANSWERS in the Search box and choose the top result.

IV. BOOKMARK YOUR FAVORITE CONTENT FOR EASY ACCESS
Add apps and other content to your Favorites for easy retrieval later on. Open the Favorites Center by clicking in the top right of any screen.

1. Open an app.
2. Right-click the app and go to File > Favorites > Add to Favorites.

3. Give your Favorite a name, choose a folder to save it in (or create a new one), and click Add to save it.

Tip: Use the Right-Click Favorites folder and your Favorites will be available in the right-click menu of any app.

For more help, see Working with Favorites: http://bit.ly/1lABHG2
Use your Floating Workspace

I. EXPLORE APPS FOR YOUR ASSET CLASS

My Apps gives you one-click access to the apps most frequently used in your asset class. For example, default apps for an equities trader include Quote List, Option Watch, and Time & Sales App.

Tip: You can rearrange apps in My Apps by dragging the icons and dropping them to a new location. You can also add or remove apps.

II. BROWSE THE APP LIBRARY

Begin typing an app name in the Search box. Results appear below.

Choose a category or asset class to narrow down your results.

Other categories help you find the apps suited to your workflow.

Click + to add an app to My Apps for faster access.

Thomson Reuters Eikon – Version 4 features a floating workspace that displays multiple apps of your choosing. This flexible format means you are not restricted to one size or shape, and can customize screen real estate to suit your needs. With just a few clicks, you can:

- add the apps you want
- size them to meet your requirements
- “snap” them together so that they move as a single entity
- stack them to create tabbed windows so that you can flip back and forth
- arrange them around other applications such as Microsoft Excel or Outlook
- link them together so that they share data

Click App Library to view the full list of available apps.

III. SET UP YOUR WORKSPACE

My Apps

gives you one-click access to the apps most frequently used in your asset class. For example, default apps for an equities trader include Quote List, Option Watch, and Time & Sales App.

IV. LINK APPS TOGETHER

V. SAVE OR SHARE YOUR WORKSPACE

VI. GET ALERTS FOR MARKET-MOVING EVENTS

VII. SYNC YOUR DESKTOP TO YOUR MOBILE DEVICE WITH MY BRIEFCASE
III. SET UP YOUR WORKSPACE

Create a new workspace

Click a workspace name to make it the active workspace. You can have up to ten workspaces open at any time.

Add apps to your workspace

When you open an app by selecting it in the app menu, the App Library, or through the Search box, it automatically becomes part of your active workspace.

This example includes a Quote List, Option Watch, and News Monitor.

The active symbol (in this case, Renault <RENA.PA>) is the most recent financial instrument you have focused on. When you add an app, it automatically displays data for the active symbol.

Right-click a workspace to save, close, or rename it.

Click Show Workspace Menu to:
• add a new workspace
• access templates for different asset classes
• share and save workspaces

Click an app title bar to move the app. Click and slowly drag an app until its frame touches another app: the two apps “snap” together, and you can move them around as a single entity.

Resize an app as you would any other window: just click the frame and drag to the new size.

Use auto-stacking so that new apps open automatically as tabs in the same window. This saves screen real estate.

Go to View > Auto Stack Window to turn auto-stacking on.

Add News Monitor to your workspace to get:
• the latest market-moving news
• historical news archives
• feature-rich, intuitive user interface

For more help, see About News Monitor: http://bit.ly/1zdAtXg

For eLearning, go to choose The News Monitor App from the Price & News Discovery category in the Training App.
IV. LINK APPS TOGETHER
You can link apps together so that they share the content of your chosen instruments. Color-coded apps “tune in” to the same data stream.

1. This example includes Index Movers App, Quote Line App, and a company overview page.
2. In the top left of each app, click Link Channel to choose a color. Choose whichever color you prefer.
3. Now that the apps are linked, type a new instrument code into any app. All other apps will automatically display content for the new instrument.

For more help, see Linking Apps: http://bit.ly/1nTLlm1

For eLearning, choose Managing the Eikon Workspace from the Learn the Basics category in the Training App.

V. SAVE OR SHARE YOUR WORKSPACE
After creating your workspace, you can save it for later use or share it with colleagues. Just right-click the workspace tab in the application toolbar, and choose Save. You will also be prompted to save any unsaved workspace changes when you close Thomson Reuters Eikon.

1. Right-click the workspace tab and choose Save.
2. To see your saved workspaces, click View Workspace Menu and choose My Workspaces.
3. View your saved workspaces and layouts. You can share content with your colleagues or other Messenger contacts – just click Share.

For eLearning, choose Managing the Eikon Workspace from the Learn the Basics category in the Training App.
VI. GET ALERTS FOR MARKET-MOVING EVENTS

Get informed immediately of market-moving information with Alerts.

1. Click in the top right of the toolbar to open Alerts.

2. Click Create New Alert.

3. Choose the type of data or event to trigger the alert.

4. Fill in the alert criteria. For example, you can receive an alert when the instrument price hits a certain threshold. You can easily combine criteria, and Autosuggest helps you find the right instrument quickly.

5. Choose how you want to receive alerts.

6. Click Set to activate your alerts.

Tip: You can set alerts directly from other apps. Just right-click the instrument you are interested in and choose Set Alert.

For more help, see Creating and Managing Alerts:
http://bit.ly/1nTsvex

For eLearning, choose Creating and Managing Alerts from the Price & News Discovery category in the Training App.
VII. SYNC YOUR DESKTOP TO YOUR MOBILE DEVICE WITH MY BRIEFCASE

With My Briefcase, you can collect news and documents and read them later, either on your desktop application or from your mobile device, even when you are offline. You can open My Briefcase by clicking in the top right of your toolbar.

1. Open an app and display filings, research, events, or news. For example, country news is available in > Markets > Countries & Regions.

2. Click Add to Briefcase.

3. Sign into your mobile device.

4. Go to Briefcase in the Applications menu to find the article you saved.

For more help, see Using My Briefcase: http://bit.ly/LPUa1s

For eLearning, choose Using the Briefcase from the Price & News Discovery category in the Training App.
Monitor your Portfolios

I. MAKE A PORTFOLIO OR LIST

Lists are sets of financial instruments that you define. Portfolios are predefined or custom lists that include the quantity of each financial instrument, as well as historical purchase prices. You can:

- create lists and portfolios
- use predefined portfolios, for example, based on major stock indices
- share them with other colleagues
- reuse them in other apps, or on your mobile device
- export them to Microsoft Excel

1. Open Portfolios and Lists. Remember, you can open an app from the app menu, or find it using the Search box.

2. In this example, let’s make a portfolio. On the Portfolios And Lists tab, click Create New.

3. Enter details for your new portfolio, including a name, benchmark index, primary asset class, and currency.

4. Click Create to make your new empty portfolio. On the next screen, you will add instruments and other details.

5. Use the tabs at the top of the app to run analytics, create reports, search for news about the instruments in your portfolio, and more.

6. Add holdings to your portfolio here. You can then indicate transaction dates and values on the Transactions tab.


Tip: Thomson Reuters Integration Services can help upload your portfolios easily. Contact your Thomson Reuters representative.
II. FOLLOW NEWS THAT AFFECTS YOUR PORTFOLIO

News Discovery offers different insight into NewsWires, Global Press, and Reuters Top News through data visualization.

- Get streaming and historical news enhanced by charts, videos, tweets, and more.
- Charts and story snippets in the headline dashboard tell you the crux of the story at a glance.
- View news on the companies in your portfolios.
- Filter by story sentiment (NewsWires only), or by date and time.
- Add advanced filters and save them just as you do in News Monitor.
- Create filters, order by date/time or sentiment, or simply view news for the current day.

News Discovery is available in the News & Research app menu, or by typing NEWSD in the Search box.

Choose how you want to filter news. In this example, let’s filter by portfolio.

Select the news sources you require, and add advanced filters in this area.

Select the portfolio you want. All news articles related to instruments in your portfolio are displayed.

Hover over the top right of an article to display the Briefcase icon. Click Add to Briefcase to save your article so that you can read it on the go from your mobile device or web browser.

Use the Timeline toggle button to display news in reverse chronological order or based on the date and time criteria you have chosen.

III. WATCH THE MARKETS WITH MONITOR

Monitor lets you watch instruments and multiple portfolios. You can create and modify your Monitor quickly and easily, choosing data fields from the Thomson Reuters Eikon database and sharing your list with colleagues.

You will find Monitor in the Monitoring app menu.

Remember, you can open an app from the app menu, or find it using the Search box.

To create your instruments, launch Monitor and just start typing. Enter ticker symbols, or type a company name and choose from Autosuggest.

Press Enter to go to the next line, Delete to delete a row, Insert to add one, Ctrl-z to undo an action, or Ctrl-y to redo one.

Right-click a header to sort data or add columns. Also use the right-click menu to access display preferences.

You can create multiple Monitor lists. The app saves your changes automatically. To access saved lists or to rename lists, click the app menu and choose File > Open or Rename.

For indices, you can expand or contract the list of constituents by clicking the gray arrow.

For more help, see Monitor: http://bit.ly/1lAH7kn

For eLearning, choose Monitor your Portfolios and Lists from the Price & News Discovery category in the Training App.
Charting and Technical Analysis

I. USE A WORKFLOW CHART

Workflow charts are predefined charts for various asset classes. You can find them under Charting.

1. Click to open the app menu.
2. Click Charting. Workflow charts for your asset class appear, along with Chart App.
3. Select a chart, for example, select Volatility Chart.
4. Fill in the instrument, analysis parameters, and other settings.
II. CREATE A CUSTOM CHART IN CHART APP

Chart App is a powerful, flexible tool for technical analysis. Build your analysis from scratch and configure it to fit your needs.

1. Click to open the app menu.

2. Click Charting. Workflow charts for your asset class appear, along with Chart App.

3. Select Chart.

4. Type an instrument code and press Enter.

5. Use toolbar buttons to adjust your chart range, interval, and line types. Click Analysis to add a new analysis.

6. In the Insert Analysis dialog box, select an analysis and click Add to insert it. To find out more about an analysis, select it and press F1 to open online help.

Tip: To edit your chart, just click any label and choose a new setting from the drop-down box that appears.

For eLearning, choose Getting Started with the Chart App from the Charting category in the Training App.

For more help, see Charting & Technical Analysis: http://bit.ly/14cMiKM
Financial Communities

I. USE THOMSON REUTERS MESSENGER

II. CONTACT CUSTOMER SUPPORT FOR HELP

III. SEND MESSAGES DIRECTLY FROM THE SEARCH BOX

IV. SEARCH THE DIRECTORY, VIEW PROFILES, AND BUILD YOUR NETWORK

Messanger is also a venue for chats and forums. Check out the weekly Global Markets Forum, where you can get commentary from leading Reuters journalists. Visit http://online.thomsonreuters.com/trading/amf/

Tip: Messenger is enhanced every month with new features. To find out about new enhancements, don’t forget to check the What’s New page frequently. Just click new in the top right of your toolbar.

For eLearning, choose Getting Started with Eikon Messenger from the Collaborating category in the Training App.

For more help, see Overview of Thomson Reuters Messenger: http://bit.ly/1niFAS8
II. CONTACT CUSTOMER SUPPORT FOR HELP

If you need help, you can contact Thomson Reuters Customer Support anytime from Messenger. Just click Customer Support in the Ungrouped category of contacts.

III. SEND MESSAGES DIRECTLY FROM THE SEARCH BOX

You can send a quick message to any of your contacts (including Customer Support) without opening Messenger.

1. Just type @ and your contact’s name in the Search box...

2. …then type your message and press Enter.

Tip: You can also write to chat rooms and groups you create in your list of contacts.

IV. SEARCH THE DIRECTORY, VIEW PROFILES, AND BUILD YOUR NETWORK

Messenger gives access to a global financial services directory for the combined Thomson Reuters Eikon and Markit Collaboration Services networks. This is the financial services industry’s first open, cross-network directory. It enables users across the industry – including those on internal networks – to find and communicate with each other safely and compliantly.

Over 250,000 users are now accessible across the combined Eikon and Markit networks.

1. In Messenger, begin typing to search for a person or company.

2. Right-click a name to view more details.

3. Click Add to My Contacts or View Profile.

4. On the profile page:
   • See the person’s profile and contact details
   • Send a message via Messenger or email
   • Add your own personal notes (not visible to other users)
   • View related contacts
Thomson Reuters Eikon – Microsoft Office

I. DISCOVER THOMSON REUTERS EIKON – MICROSOFT OFFICE

Thomson Reuters Eikon – Microsoft Office, an integral part of Thomson Reuters Eikon, is a self-installing Microsoft Excel add-in. With it, you can:

- retrieve real-time, historical, and fundamental data by using the Formula Builder or the In-Cell Builder
- analyze equities using the integrated Screener
- build charts with your financial data in your worksheets for market analyses
- access and customize advanced templates provided by Thomson Reuters
- build lists and portfolios, and access those created in Thomson Reuters Eikon Desktop
- export and link Excel data and charts to documents or presentations in Word or PowerPoint
- create presentations and documents customized to your company’s own visual identity

II. LOG INTO THOMSON REUTERS EIKON – MICROSOFT OFFICE

1. Start Microsoft Excel.
2. Click the Thomson Reuters tab to open the Thomson Reuters Eikon menu.
3. Click Log in and type your Thomson Reuters Eikon credentials if prompted.

III. USE THE FORMULA BUILDER TO RETRIEVE THOMSON REUTERS DATA

1. Select a blank cell on your worksheet, then click Build Formula on the Thomson Reuters tab.
2. In the Formula Builder, enter (or search for) the instruments you want data for.
3. Select the data source you require (real-time & fundamental or time series), then enter the data item(s) you want to include. For each data item, you can define settings in the Parameters area.
4. Select other settings, if required.
5. Select a destination cell for the data.
6. Click Insert.

Open the Training App and choose the Excel & Analytics category to see the full range of training materials for Thomson Reuters Eikon – Microsoft Office, from basic features to advanced data retrieval and automation.
IV. ENABLE DATASTREAM, DEAL ANALYTICS, LINKING, AND PRESENTATION TOOLS

Thomson Reuters Eikon – Microsoft Office includes additional apps to enhance your productivity.

**Note:** You must be permissioned to enable these apps.

1. Click **Options** on the Thomson Reuters tab.

2. Open **Apps**.

3. Click to read about and enable the app(s) you require:
   - Datastream
   - Datastream Charting
   - Deal Analytics
   - Linking

V. USE ADFIN ANALYTICS AND OTHER ADVANCED FEATURES

Adfin Analytics is a set of powerful cross-market financial calculation libraries. The libraries are targeted for financial spreadsheet users and developers of financial applications. The libraries can be used in different environments, for example in Thomson Reuters Eikon – Microsoft Office.

**Tip:** In Microsoft Excel, go to **Formulas > Insert Function** to access the Adfin Analytics functions.

For more help, see Thomson Reuters Eikon Adfin Workbook: [http://bit.ly/15g0IMo](http://bit.ly/15g0IMo)

For eLearning, choose **Getting Started with Eikon – Microsoft Office** from the **Excel & Analytics** category in the Training App.

For more help, see Thomson Reuters Eikon – Microsoft Office Help: [http://bit.ly/1hUJixa](http://bit.ly/1hUJixa)
CONTACT INFORMATION

For online help: http://bit.ly/1n8tB37

For more information on training: http://training.thomsonreuters.com/eikon4/

Or contact your Thomson Reuters representative.